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BAB I 
 

PENDAHULUAN 

 

 Low Salinity Waterflooding (LSW) atau Injeksi Air Salinitas 

Rendah merupakan salah satu metode Enhanced Oil Recovery (EOR) 

yang merupakan pengembangan dari Waterflooding konvensional. LSW 

bertujuan untuk meningkatkan perolehan minyak di reservoir dengan 

cara menurunkan salinitas pada air injeksi. 

 Low Salinity Waterflooding bertujuan untuk meningkatkan 

perolehan minyak di reservoir dengan cara menurunkan salinitas pada 

air injeksi. Dengan menurunkan salinitas air injeksi maka akan 

berpengaruh pada turunnya tekanan kapiler antara minyak dan batuan, 

menurunkan tegangan antar muka air-minyak, dan terakir mengubah 

permeabilitas relatif yang disebabkan perubahan wetabilitas. Pada 

batuan karbonat, recovery didapat lebih banyak pada penginjeksian air 

laut biasa, bukan dengan air bersalinitas rendah. Maka dapat 

disimpulkan bahwa tidak seperti batu pasir dengan kandungan clay 

tinggi, air salinitas rendah tidak mampu bekerja dengan baik pada 

reservoir karbonat karena kandungan clay nya sedikit dan 

mengandung mineral muatan positif (Lager dkk (2006). 

 Pada batuan pasir terdapat beberapa mekanisme yang dapat 

terjadi, yaitu  Fine Migration, yang mengakibatkan permeabilitas 

reservoir lebih seragam karena terjadinya swelling, kemudian 

Multicomponent Ion Exchange yang akan menyebabkan perubahan 

wettabilitas batuan, selain itu terjadi juga Ligand Bridging yang hampir 
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sama dengan MIE, dan terakhir adalah Wettability Alteration yang 

menyebabkan perubahan wettabilitas batuan. 

 Untuk LSW pada batuan karbonat terdapat dua mekanisme 

yang dapat terjadi, yaitu multi-component ion exchange yang 

mengakibatkan perubahan wetabilitas batuan, serta penurunan 

tegangan permukaan (interfacial tension/IFT). Kondisi terjadinya kedua 

mekanisme tersebut dipengaruhi oleh temperatur dan konsentrasi 

garam pada air injeksi, dimana multi-component ion exchange terjadi saat 

temperatur tinggi dan konsentrasi garam pada air injeksi tinggi, 

adapun penurunan IFT terjadi saat suhu rendah dan konsentrasi 

garam dalam air injeksi rendah. 

 Berdasarkan dua mekanisme tersebut, maka pengaruh dari 

low salinity Waterflooding pada batuan karbonat adalah dapat 

meningkatkan oil recovery dengan adanya perubahan wettabilitas 

menjadi water wet dan juga dapat menurunkan tegangan 

permukaannya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

3 

 

BAB II 

KONSEP INJEKSI AIR DENGAN SALINITAS  

RENDAH 

2.1. Pengenalan Konsep Injeksi Air dengan Salinitas Rendah  

 Injeksi air merupakan metode perolehan minyak pada tahap 

secondary recovery, dimana air formasi biasanya digunakan pada proses 

injeksi air konvensional. Pada tahap secondary recovery, metode yang 

digunakan hanyalah menambahkan energi ke dalam reservoir tanpa 

mengubah sifat fisik maupun kimia dari batuan maupun fluida 

reservoir. Namun berbeda dengan konsep injeksi air bersalinitas 

rendah (LSW) yang dapat mengganggu kondisi reservoir yang 

menyebabkan perubahan sifat fisk maupun kimia. Sehingga pada 

metode LSW ini dikategorikan pada tertiary recovery.   

LSW (Low Salinity Waterflooding) merupakan suatu teknik 

perolehan minyak tahap lanjut (EOR) dengan cara menginjeksikan air 

dengan tingkat salinitas yang rendah ke dalam reservoir akan 

mengakibatkan terjadinya reaksi kimia antara air injeksi, minyak, dan 

batuan reservoir sehingga diharapkan dapat meningkatkan perolehan 

minyak tambahan.  

Studi mengenai LSW ini telah dilakukan dua dekade terakhir 

baik penelitian di laboratorium maupun simulasi. Namun kebanyakan 

mengangkat membahas kasus di reservoir batupasir melalui penelitian 

di laboratorium. Pada  

Dengan menurunkan salinitas air injeksi maka akan 

berpengaruh pada turunnya tekanan kapiler antara minyak dan batuan, 
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menurunkan tegangan antar muka air-minyak, dan terakir mengubah 

permeabilitas relatif yang disebabkan perubahan wetabilitas. Banyak 

penelitian efek dari salinitas rendah terhadap batu pasir, namun 

terdapat juga penelitian yang dilakukan terhadap karbonat. Namun 

pada batuan karbonat, recovery didapat lebih banyak pada 

penginjeksian air laut biasa, bukan dengan air bersalinitas rendah. 

Sehingga dapat disimpulkan bahwa tidak seperti batu pasir dengan 

kandungan clay tinggi, air salinitas rendah tidak mampu bekerja 

dengan baik pada reservoir karbonat karena kandungan clay nya 

sedikit dan mengandung mineral muatan positif (Lager dkk (2006)). 

Namun beberapa studi terus ditingkatkan guna menaikkan oil recovery 

pada karbonat yang diinjeksikan air bersalinitas rendah.  

Alotaibi dkk.(2010) mekalukan studi tentang wetabilitas pada 

limestone cores menggunakan air formasi, aquifer sintetis dan air laut 

dengan konsentrasi yang berbeda. Hasilnya menunjukan bahwa air 

laut dan air formasi membuat substrat dari kalsium karbonat yang 

awalnya oil-wet berubah menjadi water-wet. Recovery tambahan juga 

diperoleh sebesar 8,6% dalam percobaan coreflooding ketika air aquifer 

diinjeksikan setelah air formasi. Penelitian terhadap efek injeksi air 

laut yang diinjeksikan kedalam karbonat telah dilakukan oleh Yousef 

et al (2011). Hasilnya 18 – 19% recovery diperoleh dibandingkan 

dengan Waterflooding biasa dengan melakukan pengenceran air laut 

hingga 20 kali secara bertahap. Percobaan ini juga telah dikaitkan 

dengan sifat wetabilitas batuan yang cenderung water-wet.  
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2.2. Mekanisme Perolehan Minyak dengan Injeksi Air dengan 

Salinitas Rendah  

 Low Salinity Waterflooding (LSW) merupakan salah satu 

metode Enhanced Oil Recovery (EOR) yang merupakan pengembangan 

dari Waterflooding konvensional. Low Salinity Waterflooding bertujuan 

untuk meningkatkan perolehan minyak di reservoir dengan cara 

menurunkan salinitas pada air injeksi. Dengan menurunkan salinitas 

air injeksi maka akan berpengaruh pada turunnya tekanan kapiler 

antara minyak dan batuan, menurunkan tegangan antar muka air-

minyak, dan terakir mengubah permeabilitas relatif yang disebabkan 

perubahan wetabilitas 

 

2.2.1. Mekanisme Injeksi Air dengan Salinitas Rendah pada 

Reservoir Batupasir 

2.2.1.1. Fine  Migration/ Permeability Reduction 

Pada prinsipnya clay cenderung terhidrasi dan mengalami 

swelling ketika terjadi kontak dengan fresh water. saat terjadi swelling,  

clay akan terpisah dari batuan dan ikut mengalir mengikuti arus 

utama. Clay tersebut akan menyumbat aliran tersebut sehingga air 

akan mengambil jalur lain dan menyapu minyak yang masih tersisa. 

Hal ini juga menyebabkan permeabilitas dalam reservoir menjadi 

lebih seragam. Penurunan  permeabilitas pada daerah yang lebih 

permeabel meningkatkan rasio mobilitas dari waterflood. Premature 

breakhtrough kemudian berkurang dan efisiensi waterflood meningkat.  
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Partikel clay yang mengalami sementasi buruk seperti kaolinit dan 

illit memberikan hasil yang lebih baik. 

Bernard (1967)  mengamati bahwa terjadinya clay 

swelling/dispersi clay disertai dengan pressure drop dan menghasilkan 

tambahan perolehan minyak.  Adapun Tang  dan Morow (1999) 

menyimpulkan bahwa mobilisasi Clay( umumnya kaoolinit) 

meningkatkan perolehan minyak Berdasarkan pengamatan 

mereka: 

1. Fired/acidized core tidak menunjukkan sensitivitas 

terhadap salinitas, sebaliknya, core yang tidak 

dilakukan pengasaman menunjukkan sensitivitas. 

2.  Pada clean sandstone, perolehan minyak dengan 

penurunan salinitas lebih sedikit dibandingkan 

dengan shaly sandstone.  

Percobaan dilakukan secara berurutan dan 

ditunjukkan dengan nomor tes(T#)  dan nomor flood (F#) 

Menggunakan nomor CS dengan air formasi (brine) CS RB. 

Adapun tahapan injeksi melibatkan perubahan komposisi 

brine yang ditunjukkan dengan huruf a, b, c. Cyclic Waterflood 

dilakukan menggunakan core yang sama untuk injeksi yang 

berulang dan setiap sebelum injeksi, nilai Sw dikembalikan 

seperti semula dan penjenuhan dengan minyak diulang 

kembali. Gambar 2.1 menunjukan hasil dari percobaan 

tersebut dimana. 



 

7 
 

1. Saat salinitas brine yang diinjeksikan diturunkan 

menjadi 0,1 CS RB minyak reproduksi lebih banyak. 

Adapun saat rasio Na+/Ca+ ditingkatkan tidak lagi 

tidak ada lagi minyak yang terproduksi 

2. Pada tahap injeksi saat penurunan salinitas brine 

menjadi 0,1 CS RB  terjadi pressure drop yang lebih 

tinggi. Hal ini menunjukkan penurunan permeabilitas 

yang disebabkan oleh fine migration. 

3.  nilai pH maksimal sebesar 9. 

4.  dari hasil pengamatan, peningkatan perolehan 

minyak pada waterflood  menunjukkan perubahan 

wetabilitas permukaan batuan dapat terjadi sebagai 

hasil dari cyclic Waterflooding dari Flood  1 (T1F1)  

sampai  Flood 3 (T1F3). 

 

 

 

 

 

 

 

Gambar 2.1 Efek Perubahan Komposisi Brine Injeksi terhadap 

Perolehan Minyak pada Cyclic Waterflood Core CS  

( Tang dan Morrow, 1999) 
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Kia et al (1987)  melaporkan bahwa injeksi dengan 

freshwater pada batupasir yang sebelumnya  terekspos oleh larutan 

garam natrium menyebabkan lepasnya partikel clay dan penurunan 

permeabilitas yang drastis. kemudian permeabilitas menurun 

namun ketika ion kalsium juga terdapat dalam larutan garam. 

kerusakan formasi hampir menghilang ketika komposisi larutan 

disesuaikan untuk memberikan luasan permukaan kalsium yang 

lebih besar dari nilai kritis yaitu 75% atau ketika fraksi ion kalsium 

pada larutan lebih besar dari 20 hingga 30%. 

2.2.1.2.  Multicomponenet Ion Exchange 

 Teori dari MIE didasarkan pada geokromatografi air 

dimana pertukaran kation merupakan fenomena normal yang 

terjadi di permukaan mineral dikarenakan perbedaan afinitas dari 

berbagai kation terhadap permukaan batuan. sedangkan pada 

sistem   crude oil/brine rock (COBR)  secara intrinsik terjadi pada 

kesetimbangan termodinamika. Penginjeksian air salinitas rendah 

dengan konsentrasi elektrolit yang berbeda dari air formasi akan 

mengganggu keseimbangan sistem dan variasi konsentrasi ion 

yang dapat menyebabkan subtitusi/pergantian kation divalen oleh 

kation monovalen. keberadaan kation divalen pada air formasi 

dapat menghubungkan batuan dengan crude oil( Gambar 

2.2).  Secara teori pertukaran kation dengan kation monovalen 

dapat melepas crude oil  dari permukaan batuan, yang akan 

mengubah wetabilitas menjadi lebih water-wet  dan meningkatkan 

perolehan minyak. 
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Gambar 2.2 Mekanisme Adhesi yang Berbeda antara 

permukaan Clay dengan Crude Oil 

(Lager et al. 2006.) 

 

Gambar 2.2 di atas menggambarkan empat mekanisme 

adhesi yang berbeda dari ujung polar( co; COO-)  antara crude oil  

dengan permukaan clay yang mana dapat diakibatkan oleh pertukaran 

kation. Adapun mekanisme dari MIT saat dilakukan LSW 

digambarkan oleh Gambar 2.3. 

2.2.1.3. Ligand Bridging  

Konsep dari ligand bridging  dapat dikatakan mirip dengan 

konsep multikomponen ion exchange (MIE). 
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Gambar 2.3 Mekanisme Multicomponent Ion Exchange pada 

Gugus Hidrokarbon Aromatik (a,b,c) dan Gugus Karboksilat 

(d,e,f) 

(Austad et al. 2010.) 

 

Adapun yang membedakan keduanya yaitu pada  Ligand 

Bridging. Terdapat ion divalen atau multivalent seperti Ca2+ atau Mg2+ 

yang teradsorpsi dengan kuat pada permukaan batuan dan berikatan 

dengan senyawa polar yang terdapat pada fasa minyak (resin atau 

Asphaltene) dan membentuk senyawa organometalik dan 

meningkatkan oil-wetness pada permukaan batuan. Sementara itu 

beberapa senyawa polar organik tersebut teradsorpsi secara langsung 

ke permukaan batuan menggantikan kation yang paling labil yang juga 

meningkatkan oil-wetness dari batuan tersebut. 

Saat LSW dilakukan akan terjadi dengan menghilangkan 

senyawa polar organik  senyawa organometalik dan 

menggantinya  dan menggantinya dengan kation yang tidak 



 

11 
 

kompleks (Lager et al 2006). Secara teori desorpsi senyawa polar 

pada permukaan batuan menjadikan batuan lebih water-wet dan 

menghasilkan peningkatan perolehan minyak. 

2.1.2.4. Wettability  Alteration  

Mekanisme lainnya pada Injeksi LSP adalah alterasi atau 

perubahan wetabilitas pada batuan. Perubahan wettability ini 

terjadi secara simultan 

 

Gambar 2.4 Ikatan Ligand Bridging antara permukaan 

Batuan dengan Senyawa Polar Hidrokarbon 

(Lager et al.. 2006.) 

dengan mekanisme lainnya.  saat ion Divalen (Ca2+ , Mg2+  ) 

tergantikan oleh ion H+ (terjadi pada mekanisme MIT), terjadi 

perubahan wetabilitas dikarenakan ion H+ teradsorpsi oleh batuan 

akan cenderung berikatan dengan senyawa polar lainnya, yaitu air 

(Gambar 2.4). Hal ini menyebabkan batuan menjadi lebh water-

wet dan perolehan minyak meningkat. 
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 Alterasi wetabilitas juga terjadi karena adanya tolakan 

elektrostatik antara oil brine dengan brine/solid. Pada saat LSW 

dilakukan, tolakan elektrostatik tersebut meningkat sehinggga film 

air antara oil/brine dengan brine/solid menjadi lebih stabil yang 

menjadikan permukaan batuan menjadi lebih water-wet. 

2.2.2. Mekanisme Low Salinity Waterflooding pada 

Reservoir Karbonat 

Pada reservoir karbonat, gugus hidrofil dari minyak (gugus 

karboksilat, -COO-) yang memiliki muatan negatif akan teradsorpsi 

ke permukaan batuan karbonat yang bermuatan positif. Hal ini 

menyebabkan permukaan batuan menjadi oil-wet. Pada saat LSW 

dilakukan, ada dua mekanisme yang dapat terjadi, yaitu multicomponent 

ion exchange yang mengakibatkan perubahan wetabilitas batuan, serta 

penurunan tegangan permukaan (interfacial tension/IFT). Kondisi 

terjadinya kedua mekanisme tersebut dipengaruhi oleh temperatur 

dan konsentrasi garam pada air injeksi, dimana MIT terjadi saat 

temperatur tinggi dan konsentrasi garam pada air injeksi tinggi, 

adapun penurunan IFT terjadi saat suhu rendah dan konsentrasi 

garam dalam air injeksi rendah. 

2.2.2.1. Multicomponent Ion Exchange (MIT) 

Pada temperatur tinggi, ion SO4
2- akan teradsorpsi ke 

permukaan batuan karbonat. Adapun ion Ca2+ yang terdapat pada air 

formasi akan bereaksi dengan gugus karboksilat di permukaan batuan 

membentuk senyawa organometalik. Multicomponent ion exchange terjadi 

saat ion Mg2+ dalam larutan menggantikan Ca2+-karboksilat sehingga 
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senyawa tersebut terlepas dari batuan, yang kemudian mengarah pada 

perubahan wetabilitas batuan menjadi lebih water-wet. 

 

Gambar  2.5. 

Mekanisme MIE Saat Ion Mg2+ dan SO4
2- Aktif Pada 

Temperatur Tinggi 

(Strand et al., 2006) 

Pada mekanisme ini, ion SO4
2- berperan dalam mengurangi 

tolakan elektrostatik sehingga ion Mg2+ dapat teradsorpsi ke 

permukaan batuan. Adapun alasan mengapa MIT hanya aktif saat 

temperatur tinggi dikarenakan afinitas ion Mg2+ lebih besar 

dibandingkan dengan afinitas ion Ca2+
 pada temperatur tinggi, dan 

sebaliknya pada temperatur rendah, afinitas Mg2+ lebih rendah 

dibandingkan dengan afinitas Ca2+ (Zhang et al., 2007). 

Pada injeksi LSW dengan mekanisme ini, air yang umum 

digunakan adalah air laut. Air laut digunakan karena pada air tersebut 

terdapat ion SO4
2- yang mana jarang atau tidak terdapat pada air 

formasi. Adapun modifikasi wetabilitas didukung oleh adanya ion 
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SO4
2- yang memiliki afinitas yang kuat terhadap permukaan batuan 

karbonat. Hal ini dapat dilihat dari Gambar 2.6. yang 

membandingkan afinitas ion SO4
2- dengan senyawa tracer SCN-. Dapat 

terlihat bahwa afinitas SO4
2- meningkat seiring dengan meningkatnya 

temperatur. 

 

Gambar 2.6.Retensi Ion SO4
2- dan SCN- Pada Temperatur 

Berbeda  

(Strand et al., 2006) 

 

a. Wettability Alteration 

Wettability Alteration merupakan suatu proses untuk 

memperbaiki suatu wettabilitas reservoir, dimana diharapkan menjadi 

ke water-wet. Dimana pada suatu reservoir tidak semuanya memiliki 

sifat water-wet, melainkan terdapat juga yang oil-wet. Dengan adanya 

reservoir yang bersifat oil-wet, maka diperlukan wettability alteration agar 
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reservoir tersebut sifatnya berubah menjadi lebih ke water-wet, Agar 

dapat meningkat Oil Recovery-nya. Pada aplikasi Enhance Oil Recovery 

(EOR) pada saat ini telah banyak yang berhasil untuk mengubah suatu 

wettabilitas pada suatu reservoir menjadi lebih ke water-water, dimana 

yang umum dilakukan adalah dengan menggunakan Chemical dan 

Thermal Enhance Oil Recovery (EOR). 

b. Pengaruh Low Salinity Waterflooding  Terhadap 

Wettability Alteration 

Pada Low Salinity Waterflooding terdapat suatu mekanisme 

yaitu Multi-component Ion Exchange (MIT), dimana pada suatu 

mekanisme tersebut dapat mengakibatkan perubahan wettabilitas 

batuan. Oleh karena itu Low Salinity Waterflooding akan mempengaruhi 

wettability alteration, sehingga suatu reservoir tersebut akan menjadi 

lebih water-wet. Oleh sebab itu, Low Salinity Waterflooding akan dapat 

meningkatkan Oil Recovery menjadi lebih besar.  

 

2.2.2.2. Interfacial Tension (IFT) Reduction 

Mohsenzadeh, et al. melakukan percobaan dengan 

menginjeksikan brine asli, brine yang telah diencerkan sebanyak 5 kali 

dan 20 kali, serta air destilasi ke dalam core batuan karbonat untuk 

mengamati pengaruh konsentrasi garam terhadap besarnya tegangan 

antarmuka/interfacial tension (IFT). Dari percobaan tersebut, diketahui 

bahwa pengenceran brine menurunkan IFT antara brine dan minyak. 

Hasil dari percobaan ini ditunjukkan pada Tabel II-1. 

Dari percobaan tersebut, diketahui bahwa perolehan minyak 

meningkat sebesar 16% menggunakan satu kali pengenceran, 22,5% 
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dengan 10 kali pengenceran, 29% dengan 20 kali pengenceran, dan 

33% dengan menggunakan air destilasi. 

Dari data tersebut, low salinity brine tidak mengubah wetabilitas 

batuan pada temperatur yang relatif rendah. Hal ini dapat dilihat pada 

pengukuran sudut kontak antara minyak dengan permukaan batuan. 

Namun di lain hal, pengukuran tegangan antarmuka menunjukkan 

bahwa brine yang diencerkan menurunkan tegangan antarmuka 

minyak-brine. Maka dari itu, penurunan tegangan antarmuka dianggap 

sebagai mekanisme utama pada LSW saat hanya terdapat sedikit ion 

aktif dalam larutan 

  Tabel II-1. 

Hasil Pengukuran IFT 

(Mohsenzadeh, A. et al. 2016) 
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Gambar 2.7. 

Hasil Pengamatan Pengaruh Pengenceran Larutan terhadap 

Sudut Kontak Minyak di Permukaan Batuan 

(Mohsenzadeh, A. et al.. 2016) 

Dari berbagai percobaan yang telah dijelaskan di atas, dapat 

disimpulkan bahwa LSW dapat dilakukan di reservoir karbonat 

dengan memanfaatkan mekanisme IFT reduction dan kehadiran ion 

aktif dengan konsentrasi tinggi bukanlah kriteria yang harus selalu 

terpenuhi. 

 

2.3. Faktor yang Mempengaruhi Injeksi air Salinitas Rendah  

Menurut Craig, dalam menentukan reservoir yang sesuai untuk 

merencanakan Waterflooding perlu dipertimbangkan faktor-faktor dan 

ini juga bisa menjadi dasar dalam proses Injeksi air salinitas rendah 

antara lain : 
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1. Geometri Reservoir 

Merupakan langkah pertama dalam penyusunan informasi 

reservoir untuk mempelajari kemungkinan digunakan Waterflooding. 

Struktur dan stratigrafi merupakan kontrol reservoir dalam 

penempatan sumur-sumur dan tingkat perluasannya, dimana hal ini 

mempunyai peranan yang penting dalam operasi injeksi air. 

Struktur merupakan faktor utama yang menentukan pemisahan 

gravitasi. Dengan adanya permeabilitas yang besar, perolehan dengan 

pemisahan gravitasi khususnya pada sumur-sumur yang sudah tua dan 

mempunyai saturasi minyak yang berkurang nilainya sehingga apabila 

injeksi air diterapkan pada sumur tersebut maka tidak ekonomis. Jika 

struktur yang ada sesuai dan saturasi minyak sisanya ternyata masih 

cukup besar untuk diterapkan operasi tahap lanjut, maka injeksi tipe 

peripheral (keliling) menghasilkan effisiensi penyapuan areal lebih 

tinggi dari pada pola konvensional atau injeksi line drive. 

 

2. Lithologi  

Lithologi mempengaruhi efisiensi Waterflooding pada suatu 

reservoir. Faktor-faktor lithologi itu diantaranya adalah porositas, 

permeabilitas dan kandungan clay. Pada beberapa sistem yang 

kompleks hanya sebagian yang kecil dari porositas total seperti pada 

reservoir  rekah alam  (porositas matriks dan rekahan) akan 

mempunyai permeabilitas relatif yang cukup relatif dalam operasi 

Waterflooding. Pada kasus ini porositas matriks kecil pengaruhnya 

terhadap program Waterflooding seperti kristalin.  
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Evaluasi pengaruh-pengaruh semacam ini memerlukan 

penyelidikan laboratorium yang lebih teliti dan studi reservoir yang 

lebih luas. Evaluasi dapat ditambah dengan percobaan operasi pilot 

injeksi.  

 

3. Kedalaman Reservoir 

Jika kedalaman reservoir terlalu besar untuk dilakukannya 

pemboran kembali secara ekonomi dan sumur tua digunakan sebagai 

sumur injeksi dan produksi, perolehan yang lebih rendah mungkin 

diharapkan daripada melakukan pemboran sumur baru. Ini terutama 

terdapat pada lapangan-lapangan tua dimana spasi sumur teratur 

belum diamati dan pengembangan infill drilling (pemboran sumur 

sisipan) tidak secara luas dikembangkan. 

Penyebab digunakannya lapangan dengan kedalaman dangkal 

karena tekanan maksimum yang dipakai dalam operasi perolehan 

tahap lanjut yang dibatasi dengan kedalaman reservoir. Dalam operasi 

Waterflooding ditemukan bahwa terdapat tekanan kritis yang 

diperkirakan hingga tekanan statik kolom batupasir atau sekitar 1 

psi/ft. Kedalaman pasir yang melebihi harga tersebut, mengizinkan 

air masuk menembus untuk memperlebar rekahan atau bidang lemah 

lain, seperti lipatan dan mungkin bidang perlapisan. Hasil-hasil ini 

terdapat dalam saluran air yang diinjeksikan atau melewati bagian yang 

luas dari matriks reservoir. Akibatnya, satu gradien tekanan operasi 

yang besarnya 0,75 psi/ft umumnya merupakan ambang batas untuk 

mencegah terbaginya tekanan. 
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4. Porositas 

Perolehan minyak total dari reservoir merupakan fungsi 

langsung dari porositas. Porositas menentukan jumlah minyak yang 

ada dengan mengetahui persentase saturasi minyaknya. Pengumpulan 

data porositas merupakan hal yang penting untuk menentukan jumlah 

minyak yang ada dalam reservoir. Besarnya porositas bervariasi dari 

10 % sampai dengan 35 % pada zona tunggal. Pada batu gamping 

dolomite, porositas yang ditunjukkan dan porositas rekah bervariasi 

dari 2 % sampai dengan 11 %. 

 

5. Permeabilitas 

Tingkat keseragaman permeabilitas suatu reservoir sangat 

berpengaruh dalam perencanaan injeksi air. Untuk mencapai 

perolehan hidrokarbon yang tinggi, suatu reservoir seharusnya 

mempunyai tingkat permeabilitas yang tinggi. Namun demikian, 

kondisi yang ideal ini tidak dijumpai dalam reservoir yang 

sesungguhnya karena banyaknya faktor geologi yang mempengaruhi. 

Jika permeabilitas seragam dari lapisan atas sampai lapisan bawah 

suatu reservoir, maka front zone injeksi akan berbentuk flat. Pendesakan 

ini disebut pendesakan piston dengan efisiensi penyapuan besar dan 

tingkat perolehan minyak akan besar pula sehingga kondisi ini 

diharapkan dalam proyek injeksi air. 

Bagaimanapun juga, banyak reservoir tidak mempunyai profil 

permeabilitas yang seragam, sebagai contoh pasir yang terendapkan 

pada barrier pantai cenderung lebih kasar pada bagian atas dan profil 

permeabilitasnya tinggi pada bagian atas serta terendah pada bagian 
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bawah. Apabila air diinjeksikan pada formasi ini, maka air akan lebih 

cepat bergerak pada zona yang permeabilitasnya tinggi, sehingga 

hasilnya adalah air akan mencapai sumur produksi pertama kali pada 

zona atas (over run) dan hanya akan menyapu sebagian zona yang lebih 

rendah dengan konsekuensi hilangnya efisiensi perolehan minyak 

secara keseluruhan. 

Pada formasi yang memiliki profil permeabilitas tidak teratur, 

front injeksi akan tidak teratur dan kemajuannya berbentuk finger, hal 

ini mengakibatkan sebagian volume reservoir dilalui oleh injeksi air 

dan besarnya effisiensi penyapuan tidak begitu tinggi, artinya masih 

ada minyak yang tersisa dalam reservoir.  

Kondisi terburuk adalah adanya lapisan tipis dimana tingkat 

permeabilitasnya sangat tinggi pada formasi yang seragam, air dengan 

cepat akan muncul pada sumur produksi melalui lapisan tipis tersebut 

dan akan meninggalkan sebagian besar minyak dalam reservoir. 

Untuk mengatasi masalah ini, maka perlu dilakukan plugging pada 

formasi yang mempunyai tingkat permeabilitas terbesar, sehingga 

diharapkan effisiensi perolehan minyak cukup tinggi. 

 

2.4. Sistem Pengolahan Air Injeksi 

Tidak seperti Waterflooding konvensional dimana air yang 

digunakan dapat  menimbulkan masalah seperti scale , baik di pipa 

maupun direservoir, air yang digunakan pada LSW berupa brine. Air 

tersebut memiliki salinitas yang sangat rendah dan tidak terlalu 

menimbulkan masalah pada pipa dari reservoir, walaupun pada 
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kenyataanya pengolahan air injeksi mungkin diperlukan untuk 

meminimalisasi dan meningkatkan efektivitas dari LSW. 

 Berikut merupakan treatment yang umumnya diberikan pada 

air injeksi 

1. Aeration 

Merupakan proses pemecahan air menjadi partikel 

partikel halus ke dalam suatu ruangan. Proses ini 

dimaksudkan untuk pengoksidasian besi dan mangan 

yang terdapat dalam air, sehingga hasil oksidasinya dapat 

tersaring. Aeration juga diinginkan untuk menghilangkan 

karbondioksida dan hidrogen sulfida dalam air. Aeration 

sudah tentu menyebabkan penambahan kadar oksigen 

dalam air dan hal ini dapat menjadikan air lebih korosif. 

Tetapi metode ini terutama dipakai untuk air yang 

mengandung besi dan mangan, karbondioksida dan 

hidrogen sulfida. 

2. Penambahan Zat Kimia (Chemical Treatment) 

Chemical treatment ini berfungsi untuk 

menghilangkan senyawa yang dapat menghilangkan 

korosi, scale dan swelling.  

3. Setting atau Pengendapan 

Untuk mendapatkan padatan-padatan yang 

tersuspensi dalam air, sehinggga dapat memisahkan 

benda padat yang halus seperti lumpur, clay, sand, dan silt 

dari air. Tempat-tempat yang biasa digunakan untuk 
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pengendapatan ini adalah oil skimmer tank atau skimming 

pit. 

4. Algae Treatment 

Merupakan penambahan zat-zat kimia seperti klor, 

hipoklorit, tembaga sulfida dan fenol kedalam air. Zat ini 

diinjeksikan kedalam air sebagai gas dalam jumlah kecil 

dan terus menerus. 

5. Penyaringan 

Untuk menyaring partikel-partikel yang tersuspensi 

dalam air dengan ukuran yang lebih kecil. Penyaringan 

ini dilakukan setelah treatment terhadap zat-zat yang 

berbentuk endapan 

6. De-aeration 

De-aeration adalah proses pemecahan air menjadi 

partikel dalam suatu ruang hampa, sehingga oksigen 

bersatu dengan udara kemudian dikeluarkan oleh vacuum 

pump. 

Dalam prakteknya pengolahan tersebut 

diklasifikasikan dalam tiga sistem yaitu terbuka, setengah 

terbuka dan sistem tertutup (dalam garis besarnya seperti 

pada pressure maintenance) 

 

2.5. Perencanaan Low Salinity Waterflooding 

Perencanaan LSW dapat dikatakan sama seperti perencanaan 

pada waterflood umumnya, dikarenakan keduanya memiliki tahapan 

yang sama dalam pelaksanaannya, adapun perbedaannya terletak pada 
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reaksi kimia yang dimiliki LSW sedang waterflood biasa tidak terjadi. 

Perencanaan tersebut didasarkan pada pertimbangan teknik dan 

keekonomisannya. Analisa ekonomis tergantung pada perkiraan hasil 

dari proses waterflood itu sendiri. Perkiraan ini bisa baik atau buruk 

tergantung pada kebutuhan khusus dari proyek atau keinginan 

pelaksana. Lima langkah utama dalam perencanaan waterflood adalah: 

1. Evaluasi reservoir meliputi hasil hasil produksi dari primary 

recovery 

2. Pemilihan waterflood plan yang potensial 

3. Perkiraan laju injeksi dan produksi 

4. Prediksi oil recovery untuk setiap perencanaan proyek 

waterflood 

5. Identifikasi variabel-variabel yang menyebabkan 

ketidaktepatan analisa secara teknik 

Analisa teknik produksi waterflood dilakukan dengan 

memperkirakan jumlah volume dan kecepetan fluida. Perkiraan diatas 

juga berguna untuk penyesuaian atau pemilihan peralatan serta sistem 

pemeliharaan (treatment) fluida. 

A. Penentuan Lokasi Sumur Injeksi-Produksi 

Pada umumnya dipegang prinsip bahwa sumur-sumur yang 

sudah ada sebelum injeksi dipergunakan secara maksimal pada waktu 

berlangsungnya injeksi nanti. Jika masih diperlukan sumur-sumur 

baru maka perlu ditentukan lokasinya. Untuk memilih lokasi 

sebaiknya digunakan peta distribusi cadangan minyak tersisa. Pada 

daerah yang sisa minyaknya masih besar mungkin diperlukan lebih 

banyak sumur produksi daripada daerah yang minyaknya tinggal 
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sedikit. Peta isopermeabilitas juga membantu dalam memilih arah 

aliran supaya penembusan fluida injeksi (breakthrough) tidak terjadi 

terlalu dini. 

B. Penentuan Pola Sumur Injeksi-Produksi 

Salah satu cara untuk meningkatkan faktor perolehan minyak 

adalah dengan membuat pola sumur injeksi-produksi, yang bertujuan 

untuk mendapatkan pola penyapuan yang seefisien mungkin. Tetapi 

kita harus tetap memegang prinsip bahwa sumur yang sudah ada 

sebelum injeksi harus dapat digunakan semaksimal mungkin pada 

waktu berlangsungnya injeksi nanti. 

Pertimbangan-pertimbangan dalam penentuan pola sumur 

injeksi-produksi tergantung pada: 

1. Tingkat keseragaman formasi, yaitu penyebaran 

permeabilitas ke arah lateral maupun ke arah vertikal 

2. Struktur batuan reservoir meliputi patahan, kemiringan, 

dan ukuran 

3. Sumur-sumur yang sudah ada (lokasi dan penyebaran) 

4. Topografi 

5. Ekonomi 

Pada operasi waterflood sumur-sumur injeksi dan produksi 

umumnya dibentuk dalam suatu pola tertentu yang beraturan, 

misalnya pola garis lurus, empat titik, lima titik, tujuh titik, dan 

sebagainya (Gambar 2.8.). 
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Gambar 2.8. 

Pola-Pola Sumur Injeksi-Produksi 

 

Pola sumur dimana sumur produksi dikelilingi oleh sumur-

sumur injeksi disebut dengan pola normal. Sedangkan bila sebaliknya 

yaitu sumur-sumur produksi mengelilingi sumur injeksi disebut 

dengan pola inverted. Masing-masing pola mempunyai sistem jaringan 

tersendiri yang mana memberikan jalur arus berbeda-beda sehingga 

memberikan luas daerah penyapuan yang berbeda-beda. 

C. Penentuan Debit dan Tekanan Injeksi 

Debit injeksi yang akan ditentukan di sini adalah untuk sumur-

sumur dengan pola tertutup dengan anggapan bahwa mobility ratio (M) 
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sama dengan satu. Besarnya debit injeksi tergantung pada perbedaan 

tekanan injeksi di dasar sumur dan tekanan reservoirnya. 

 

▪ Pola Direct Line Drive (d/a≥1), 
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▪ Pola Staggered Line Drive (d/a ≥1), 
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▪ Pola Five Spot (d/a = 0,5), 
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▪ Pola Seven Spot, 
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Keterangan : 

 i =  laju injeksi, bbl/day 

 kw =  permeabilitas efektif terhadap air, mD 

 h =  ketebalan, ft 

 ΔP =  perbedaan tekanan di dasar, psi 
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 μw  =  viscositas air, cp 

 d =  jarak antara sumur tidak sejenis, ft 

 a =  jarak antara sumur sejenis, ft 

 rw  =  jari-jari efektif sumur, ft 

D. Penentuan Tekanan Injeksi 

Tekanan Injeksi LSW diatur agar tidak mencapai tekanan rekah 

formasi untuk menghindari terbentuknya rekahan di formasi. 

Besarnya tekanan formasi dapat diketahui menggunakan Leak Off Test 

(LOT) atau Formation Integrity Test (FIT). 
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BAB III 

PEMODELAN DENGAN COMPOSITIONAL  

SIMULATOR 

 Proses pengolahan data untuk injeksi Low Salinity 

Waterflooding dapat dilakukan menggunakan beberapa simulator 

reservoir namun dalam penelitian ini peneliti menggunakan Simulator 

CMG  yang memang telah digunakan oleh beberapa peneliti 

sebelumnya untuk proses simulasi reservoir. CMG sendiri terdiri dari 

beberapa jenis didalamnya yang dapat digunakan sesuai kebutuhan, 

seperti IMEX, GEM, dan STARS. IMEX digunakan untuk black oil, 

sedangkan GEM digunakan untuk minyak jenis compositional, GEM 

juga digunakan untuk proses Enhanced Oil Recovery (EOR), dan STARS 

dapat digunakan proses injeksi EOR maupun thermal.  

 Adapun pengolahan dan simulasi reservoir  untuk penelitian 

tentang Low Salinity Waterflooding  ini akan menggunakan simulator 

GEM CMG yang memang dapat melakukan proses simulasi untuk 

Low Salinity Waterflooding selain STARS. Secara umum proses input 

dan pengolahan data terdapat beberapa bagian utama yaitu : 

1. Data Reservoir 

2. Component 

3. Rock Fluid 

4. Initial Conditions 

5. Wells & Recurrent 
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 Pada bab ini akan diuraikan bagaimana proses input data dan 

pengolahan data untuk Simulasi Waterflooding dan Low Salinity 

Waterflooding. Pada bab ini akan diuraikan proses pengolahan data 

menjadi 4 bagian utama, yaitu proses pembuatan model, Proses Input 

Sumur Injeksi Waterflooding, Low Salinity Waterflooding, dan Cara  

menampilkan grafik hasil Running pada GEM CMG. 

 

3.1. Input dan Pembuatan Model Reservoir 

Model suatu reservoir dapat dibuat dengan cara input data 

grid dan data lainnya yang tersedia untuk pembuatan model reservoir 

namun juga dapat di Import langsung melalui menu reservoir jika data 

yang diinginkan telah tersedia,sehingga dapat berupa peta real suatu 

Lapangan. Pada penelitian ini, model reservoir yang disimulasikan 

merupakan model sintetic dengan format grid kartesian, sehingga tidak 

perlu dilakukan proses history matching seperti pada pengolahan data 

real model lapangan dan berikut ini merupakan Langkah-langkah 

dalam pembuatan model dan input data reservoir. 

 

3.1.1. Builder  

 Langkah pertama dalam pembuatan model dan simulasi 

reservoir adalah dengan memilih Builder terlebih dahulu sehingga 

dapat dilakukan proses selanjutnya, Adapun Langkah-langkah awal  

dalam proses simulasi adalah sebagai berikut : 

 

 

 



 

31 
 

1. Klik CMG Launcher pada Desktop  

2. Setelah CMG Technologies Launcher Box  keluar,klik 

icon Builder  

 

 

   Gambar 3.1. Tampilan Menu Builder 

 

3. Setelah Icon Builder keluar, klik New lalu klik GEM. 

Setelah itu pada menu Working Units, klik Field. Kemudian 

pada menu Porosity, klik Single Porosity. Masukkan tanggal 

dimulainya simulasi pada Simulation Start Date. Kemudian 

klik OK. 
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Gambar 3.2. Tampilan menu awal Builder 

 

 

  Gambar 3.3. Tampilan Menu Builder Lanjutan 

 

3.1.2. Input data Component 

 Dalam proses input Component dapat dilakukan dengan 

menggunakan Winprop dan menggunakan Builder langsung namun 

jika data yang tersedia cukup lengkap dapat dilakukan menggunakan 

Winprop karena dengan menggunakan Winprop dapat dilakukan 

proses matching dari data lapangan dengan data Lab sehingga akan 

didapatkan nilai yang mendekati kebenaran. Setelah proses input data 
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pada Winprop telah selesai dapat dilakukan Import data from 

Winprop pada menu Component.  

 Untuk Input Component pada penelitian ini menggunakan 

Builder karena keterbatasan data yang tersedia, adapun Langkah-

langkah dalam proses input data Component adalah sebagai berikut 

1. Pada menu pilih terlebih dahulu menu Components 

kemudian Klik  > Model > Pilih Persamaan Peng-

Robinson > Apply  

Setelah selesai pilih Reservoir Temperature dan Input nilai 

Temperature > OK 

 

Gambar 3.4. Tampilan Menu Components  

 

2. Selanjutnya pada menu components pilih Add/Edit 

Components > Pada menu working EOS SET dan Add an 

EOSset Kemudian selanjutnya pilih Add/Edit 

Component 
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Gambar 3.5. Tampilan Menu Add/Edit Components 

 

3. Kemudian setelah menu working add/edit Component 

muncul, pilih Select From Library List > Pilih Component 

> OK  

           

 Gambar 3.6. Tampilan Menu Component Properties 
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4. Setelah Input Component Defenition Selesai selanjutnya 

pilih Interaction Parameters dan Input data, kemudian 

pilih menu working Viscosity dan input data  

 Setelah selesai Klik > OK  

 

 

 

 

 

 

 

  Gambar 3.7. Tampilan Menu Interaction Parameters 

 Jika data yang diimport telah di input maka akan centang 

seperti gambar dibawah ini 

 

 

 

 

 

 

 

 Gambar 3.8. Tampilan Model Tree View Ceklis 

Components 
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3.1.3. Input Reservoir 

 Setelah dilakukan input components selanjutnya dapat 

membuat Grid untuk model reservoirnya, dengan cara : 

1. Pada menu reservoir kemudian pilih Create Grid dan 

selanjutnya dapat memilih jenis grid yang akan digunakan 

yaitu Cartesian Grid, selanjutnya akan keluar tampilan 

seperti ini 

      Reservoir > Create Grid > Cartesian Grid > OK 

 

 

 

 

 

 

 Gambar 3.9. Tampilan Menu Reservoir Setelah Input 

Grid 

2. Selanjutnya Input data properties dengan Double klik 

pada Array Properties pada menu tree view untuk reservoir. 

Kemudian input data Grid Thickness, Porosity dan 

Permeability, Pressure dan Composition oil dan data lainnya 

yang tersedia 
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Array Properties > Input data > OK                                

 

 Gambar 3.10. Tampilan Menu Array Properties 

 

3. Setelah Array Properties selanjutnya Input data Rock 

Compressibility sesuai data yang tersedia pada Menu tree 

view kemudian  Double Klik Rock Compressibility dan 

Input data Rock Compresibility 

     Rock Compresibility > Input Data > OK 

             

 Gambar 3.11. Tampilan Menu Rock Compresibility 
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 Hasil tampilan Menu Reservoir setelah input data akan ceklis 

seperti diatas 

              

 Gambar 3.12. Tampilan Model Tree View Ceklis 

Reservoir 

   

3.1.4. Input Rock Fluid 

 Setelah input data reservoir selanjutnya dapat dilakukan input 

data Rock Fluid dengan Langkah sebagai berikut : 

1. Pada menu tree view pilih Menu Rock Fluid, 

Kemudian > Klik Create/Edit Rock Type.  

 Rock Fluid > Create/edit Rock Type > Rock Type > 

New Rock Type > Uncheck capillary Pressure 

Hysteresis > Input data yang tersedia > OK  
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Gambar 3.13. Tampilan Menu Rock Fluid 

 

2. Input data sesuai data yang tersedia, jika mempunyai dat 

PC maka check pada capillary Pressure Hysteresis  dan 

jika tidak mempunyai data tersebut dapat dilakukan 

Uncheck. 

3. Berikut merupakan hasil tampilan Menu Rock Fluid 

setelah dilakukan Input data  
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 Gambar 3.14. Tampilan Hasil Rock Fluid Setelah 

Input Data 

 

3.1.5. Input Initial Condition 

 Langkah selanjutnya setelah input Rock Fluid adalah input 

Initial Conditions.Berikut merupakan Langkah-langkah dalam 

Input data Initial Conditions   

1. Initial Conditions > Initialization Settings  

 Pada calculation methods pilih User Specified Pressure 

and saturations for each grid Block 
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  Gambar 3.15. Tampilan Menu Initialization Setting 

   

       

  Gambar 3.16. Tampilan Model Tree View Initilization 

Settings  

3.1.6. Input Data Sumuran dan Waktu  

 Setelah proses Input data reservoir dan komponen lainnya 

selesai, selanjutnya input data sumuran dan waktu sumur mulai 

berproduksi, berikut merupakan Langkah-langkah dalam input data 

sumur dan waktu. 
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 Gambar 3.17. Tampilan Menu Input Wells & Time 

 

1. klik kanan pada Wells untuk membuat dan 

menambahkan sumur  

2. Pada menu ID&Type Input nama sumur pada Name, 

Tipe sumur pada Type, dan Sumur mulai produksi pada 

Simulation Start Date Pada menu constraints Centang pada 

Constraint Definition dan Input data Surface Oil Rate dan 

BHP sumur  

 

 Gambar 3.18. Tampilan Menu Working Well  Produksi 
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3. Kemudian Input Perforasi sumur pada menu Wells input 

zona perforasi sumur dengan klik pada well-1 dan 

selanjutnya klik PERF 

 

 

 

 

 

 

 

 Gambar 3.19. Tampilan Wells Input Perforasi 

4. Tampilan menu perforation dan Selanjutnya tentukan 

zona perforasi sumur dengan klik Begin dan pilih zona yang 

diinginkan 

          

Gambar 3.20. Tampilan Well Completion 
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5. Setelah input data sumur dapat dilakukan Input Date, 

yaitu tahun simulasi akan dilakukan selama berapa tahun, 

   Klik Dates > Add range of Dates > OK 

 

Gambar 3.21. Tampilan Menu Dates 

  

6. Setelah semua data sudah di Input maka simulasi dapat 

dilakukan dengan hanya sumur produksi karena belum 

dilakukan input data untuk Sumur Injeksi.  

Save file builder yang telah dibuat, kemudian pada 

tampilan builder klik Validate With Gem dan Pilih Run 

Normal Immediately tunggu sampai proses Running 

selesai  
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Gambar 3.22. Menu Running Program 

 

    

Gambar 3.23.  Tampilan Proses Running 
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3.2. Input Data Sumur Injeksi Waterflooding 

 Setelah proses selesai selanjutnya dapat dilakukan proses 

simulasi untuk Waterflooding dengan membuat sumur injeksi terlebih 

dahulu. Dalam proses injeksi Waterflooding hanya dilakukan input data 

sumur dan tidak perlu untuk menambahkan komponen air lainnya 

karena sudah ada properties air dalam model yang telah dibuat namun 

akan berbeda Ketika akan dilakukan Injeksi Low Salinity Waterflooding 

Selanjutnya membuat atau menambahkan sumur Injeksi sama seperti 

membuat sumur diawal Input nama sumur, tipe sumur dan mulai 

beroperasi, namun selanjutnya diubah pada tipe sumur menjadi 

Injector pada menu working Type  

1. Klik Type >  Ganti menjadi Injector 

2. Kemudian setelah diganti menjadi Injector, dapat 

dilakukan pengaturan waktu mulai injeksi pada Simulation 

start date 

3. Kemudian pada menu Constraints tambahkan Surface 

Water Rate dan input nilai water yang akan diinjeksikan 

perharinya 
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Gambar 3.24. Tampilan Menu Working Well Injeksi 

 

4. Running proses Running dapat dilakukan Ketika 

semua proses input data sudah dilakukan Save file builder 

yang telah dibuat, kemudian pada tampilan builder klik 

Validate With Gem dan Pilih Run Normal Immediately 

tunggu sampai proses Running selesai  

        

 Gambar 3.25. Menu Running Program Setelah Input 

Injeksi 
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Gambar 3.26.  Tampilan Proses Running 

 Setelah Proses Running selesai dapat dilanjutkan dengan 

melihat hasil simulasi dalam bentuk grafik menggunakan CMG Results 

Graph 

 

3.3. Input data untuk Injeksi Low Salinity Waterflooding 

 Setelah dilakukan simulasi Waterflooding selanjutnya dapat 

dilakukan proses simulasi untuk Low Salinity Waterflooding dengan 

mengubah Injected Fluid pada sumur Waterflooding yang telah 

disimulasikan sebelumnya. Dalam proses injeksi Waterflooding 

sebelumnya hanya dilakukan input data sumur dan tidak perlu untuk 

menambahkan komponen air lainnya karena sudah ada properties air 

dalam model yang telah dibuat namun pada Injeksi Low Salinity 

Waterflooding kali ini akan dilakukan Input Komponen data Air Injeksi 

sesuai dengan data tersedia. 

Berikut Langkah-langkah dalam proses Injeksi Low Salinity 

Waterflooding namun Sebelum Injeksi dengan Low Salinity Waterflooding 
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(LSW)  Copy terlebih dahulu file format .dat dari pengolahan Injeksi 

Waterflooding sebelumnya untuk kemudian di ubah menjadi Injeksi 

LSW 

Klik Builder pada CMG Launcher, Kemudian pada menu pilih File  

File > Open > Pilih file format .dat > OK 

1. pilih menu Components > Process Wizard  

2. Kemudian Pilih Low Salinity Water Injection dan klik 

Next  

 

Gambar 3.27.  Tampilan Menu Process Wizard 

 Setelah itu pada  menu Input Spesific data for LSW 

Models Ceklist change the aqueos or mineral reaction structure dan 

Custom pada choose from one of the following options diganti 

menjadi Carbonates Ion Exchange Carboxylate. Selanjutnya 

Input data initial air formasi dan  initial mineral formasi data yang 

tersedia dan selanjutnya klik Next  
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Gambar 3.28.  Tampilan Menu Step 2 Process Wizard  Input 

data salinitas Formasi 

 

3. Kemudian pilih Rock Fluid region Number > Next 

 

 Gambar 3.29.  Tampilan Menu Step 3 Process Wizard 

Pemilihan Rock Region 
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4. Setelah itu Input data salinitas untuk masing-masing 

kandungan mineral dalam air injeksi sesuai data yang tersedia, 

kemudian pilih sumur injeksi dengan klik All pada menu 

working auto select well dan Klik Finish 

 

 

Gambar 3.30.  Tampilan Menu Step 4 Process Wizard  Input 

Component Water Injection 
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 Hasil Perubahan Fluida Injekasi sebelumnya waterflood 

menjadi LSW (Aqueos)  

 

 

Gambar 3.31.  Tampilan Menu Injected Fluid  

 

5. Setelah input data injeksi air maka selanjutnya dapat 

dilakukan Running dengan cara yang sama sesuai Langkah 

sebelumnya  

 Save file terlebih dahulu, kemudian validate with gem dan 

run normal immediately 

 Setelah proses Running dilakukan, dapat dilihat hasil 

perbandingan dari Waterflooding dengan Low Salinity 

Waterflooding dengan cara  menampilkan grafik pada Launcher 

CMG Results Graph 
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3.4. CMG Launcher Results Graph 

 Hasil Running yang dilakukan sebelumnya pada Builder 

selanjutnya dapat ditampilkan dalam bentuk Grafik pada Results  

Graph CMG. Pada Results Graph dapat dilihat hasil Running 

sebelumnya seperti Grafik Oil Rate, Rate Injeksi, Cumulative Oil, dan 

Grafik grafik lainnya. 

Berikut merupakan Langkah-langkah untuk menampilkan grafik hasil 

Running pada Results Graph CMG. 

1. Buka kembali CMG Launcher kemudian pilih dan klik 

Results Graph 

 

2. Selanjutnya pada menu pilih File 

File > Open > Pilih file format .irf 

 

Gambar 3.32. Pemilihan file .irf Results Graph  
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Gambar 3.33. Tampilan Menu Results Graph  

3. Selanjutnya pilih add curves pada menu untuk 

menambahkan grafik yang di inginkan, seperti grafik rate oil, 

Add Curves > Parameters > Oil Rate SC Daily > Origins 

> Well 1 > OK 

 

Gambar 3.34. Tampilan Menu Results Graph  
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4. Selanjutnya untuk menambahkan grafik Low salinity 

Waterflooding yang berbeda file  dengan Waterflooding, yaitu 

Klik Add Diference Property > Pilih File LSW format .irf > 

OK 

 Setelah selesai pilih grafik yang akan dibandingkan yaitu 

grafik Oil Rate maupun Cumulative Produksi  

 

5. Hasil Grafik Oil Rate  

 

Gambar 3.35. Hasil Grafik Oil Rate  
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6. Hasil Grafik Cumulative Oil  

    

 

 Gambar 3.36. Hasil Grafik Cumulative Oil 
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BAB IV 

STUDI KASUS PEMODELAN RESERVOIR INJEKSI AIR 

DENGAN SALINITAS RENDAH PENGURASAN 

MINYAK RINGAN 

 

 

Low Salinity Waterflooding (LSW) merupakan salah satu 

metode Enhanced Oil Recovery (EOR) yang merupakan pengembangan 

dari Waterflooding konvensional. Low Salinity Waterflooding bertujuan 

untuk meningkatkan perolehan minyak di reservoir dengan cara 

menurunkan salinitas pada air injeksi. Dengan menurunkan salinitas 

air injeksi maka akan berpengaruh pada turunnya tekanan kapiler 

antara minyak dan batuan, menurunkan tegangan antar muka air-

minyak, dan terakhir akan mengubah permeabilitas relatif yang 

disebabkan perubahan wetabilitas batuan.  

Mekanisme perolehan minyak pada Low Salinity Waterflooding 

tidak jauh berbeda dengan Waterflooding konvensional. Perbedaannya 

terletak pada migrasi butir clay dan pertukaran kation yang terjadi 

antara air dan batuan. Karena adanya mekanisme tambahan pada Low 

Salinity Waterflooding, maka ada beberapa syarat tambahan agar Low 

Salinity Waterflooding dapat dilakukan, yaitu harus terdapat clay di 

reservoir dan terdapat Conate Water, serta belum pernah dilakukan 

firing/acidizing pada reservoir. Alasan lain digunakannya Low Salinity 

Waterflooding yaitu biayanya yang cukup murah dan bahan yang mudah 

didapatkan, serta tidak memerlukan tekanan injeksi yang besar. 
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 Penelitian tentang Low Salinity Waterflooding terus dilakukan 

oleh para peneliti saat ini karena  Low Salinity Waterflooding memiliki 

beberapa keunggulan dari metode Enhanced Oil Recovery (EOR) lainnya.  

Beberapa peneliti telah melakukan penelitian seperti para peneliti 

sebelumnya untuk mengetahui mekanisme yang sebenarnya terjadi 

pada proses Low salinity Waterflooding. Salah satu metode penelitian 

yang dilakukan oleh para peneliti adalah dengan cara Modelling dan 

Numerical Simulation. Penelitian Low Salinity Waterflooding dengan 

simulasi pernah dilakukan oleh Jerauld dkk.(2008). Mereka 

mengembangkan model untuk Low Salinity Waterflooding dengan 

memodifikasi model dari waterflood konvensional. Dalam modelnya, 

NaCl dimodelkan sebagai komponen utama dalam  aqueous phase; 

permeabilitas relatif dan tekanan kapiler dijadikan sebagai fungsi 

salinitas. Namun, model ini hanya tergantung salinitas linier 

sederhana yaitu pada saturasi minyak sisa saja, yang tidak sesuai 

dengan kasus nyata. Penelitian lainnya pernah dilakukan oleh 

Rueslatten dkk. (2008). Mereka melakukan percobaan Low Salinity 

Waterflooding pada sampel core North Slope. Model yang digunakan 

merupakan model yang mempunyai reaksi geokimia dengan simulator 

PHREEQC, model dibuat untuk mensimulasikan LSW. Model ini 

hanya memberikan perkiraan variasi pH sebagai mekanisme LSW.  

 Berbeda dengan para peneliti sebelumnya yang bertujuan 

untuk mengetahui mekanisme yang terjadi pada Low Salinity 

Waterflooding, Penelitian ini hanya bertujuan untuk melihat  perolehan 

minyak jika menggunakan Waterflooding konvensional dan low salinity 

Waterflooding atau injeksi air salinitas rendah. 
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Penelitian ini  menggunakan simulator komposisional GEM 

CMG yang memang dapat digunakan untuk injeksi air salinitas rendah 

dengan memperhitungkan adanya reaksi kimia sehingga dapat 

memperoleh hasil yang lebih maksimal. Simulator ini bisa menghitung 

reaksi Ion-Exchange, aqueos reaction, dan mineral dissolution. Pada 

penelitian ini permeabilitas relative dan komposisi oil menggunakan 

data penelitian Dang et.al (2016), tetapi model geologi yang digunakan 

merupakan model homogen dengan bentuk reservoir kubus karena 

penelitian ini hanya akan berfokus untuk mengamati perolehan 

minyak dari low salinity Waterflooding.  Model reservoir dalam bentuk 

2D dapat dilihat pada Gambar 4.1.  

Model reservoir homogen tiga dimensi yang terdiri dari blok 

grid 21 * 21 * 5 dengan properti yang disajikan pada Tabel 4.1. 

 

Tabel IV.1. Properti Reservoir 

Parameter Value 

Grid block dimensions 21 * 21 * 5 

Grid block sizes x = 160 ft, y = 160 ft, z = 

15 ft 

Permeabilities (kh, kv), mD 200 

Porosity 0.2 

CEC 50 

Reservoir Pressure, psi 2000 

Reservoir Temperature, F 185 

Initial water saturation 0.15 
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      Gambar 4.1. Model Reservoir 2D 

Data komposisi oil dan permeabilitas relative berdasarkan 

Dang et al(2016) ditampilkan dalam Tabel IV.2 dan Gambar 4.1 

dibawah ini. 

Tabel IV.2.  Komposisi Oil 

Ion Fraction 

CO2 0.01 

CH4 0.19 

C3H8 0.13 

FC6 0.17 

FC10 0.3 

FC15 0.15 

FC20 0.05 

 



 

61 
 

 

Gambar 4.2 Kurva Permeabilitas Relative 

Produksi dilakukan selama 50 tahun dimulai dari Januari 

2000 sampai dengan januari 2050, dengan hanya satu sumur produksi. 

Produksi dilakukan pada semua layer dengan Bottom Hole Pressure 

BHP sebesar 100 psi dengan constraints rate produksi sebesar 2000 

bbl/day.  Selama sumur berproduksi tidak dilakukan program lainnya 

hanya dilakukan program sumur injeksi yang dimulai pada awal 

januari 2000 dengan jumlah sumur injeksi sebanyak 4 sumur.  

Program sumur injeksi dilakukan dengan  pola 5-spot, rate 

injeksi sebesar 1000 bbl/day dan diinjeksikan ke semua layer reservoir. 

Skenario yang dilakukan adalah sebanyak 3 skenario. Skenario 

pertama yang merupakan basecase adalah injeksi Waterflooding 

konvensional yaitu dengan injeksi  salinitas air formasi. Kedua adalah 

Low salinity Waterflooding dengan air injeksi yang telah diencerkan 10 
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kali dari air formasi sehingga salinitas airnya berkurang. Kemudian 

yang ketiga adalah injeksi dengan air formasi yang diencerkan 

sebanyak 20 kali dari air formasi atau Low salinity Waterflooding kedua. 

Komposisi dari air formasi dan air injeksi dapat dilihat pada Tabel 

IV.3 dibawah ini. 

Table IV.3 Komposisi air formasi dan injeksi 

Ion Formation 

Water (ppm) 

LSW-FW 10x 

diluted (ppm) 

LSW-FW 10x 

diluted (ppm) 

Na+ 49,933 4993.3 2496.65 

Ca2+ 3,248 324.8 162.4 

Mg2+ 14,501 1450.1 725.05 

Cl- 111,810 11181 5590.5 

SO4
2- 234 23.4 11.7 

HCO3
- 3658 0.3658 0.1829 

TDS 

(mg/L) 

179,730 17,973 8986.3 

 

Berdasarkan model reservoir yang telah dibuat dengan data 

yang tersedia didapatkan original oil in place OOIP sekitar 19 MMSTB. 

Berikut merupakan uraian hasil simulasi yang didapatkan mulai dari 

tahap awal sampai tahap prediksi. Komposisi oil dimasukkan ke 

dalam component (simulator GEM), dan komposisi brine dan air yang 

diinjeksi dimasukkan ke dalam Process Wizard (simulator GEM). 

Simulasi ini mempertimbangkan pertukaran ion Ca2 + - X. Kalsit dan 

dolomit merupakan mineral utama dalam reservoir ini. Perubahn 

permeabilitas juga tergantung pada reaksi air dan mineral. Setelah 
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mengidentifikasi komponen dan reaksinya, dapat membuat sumur 

dan event pada sumur seperti jenis sumur dan constraints sumur. Lokasi 

sumur dan bentuk 3D model reservoir dapat dilihat pada Gambar 

4.3. 

  

Gambar 4.3.  Model Reservoir 3D 

Setelah proses Running program skenario selesai, maka dapat 

dilakukan analisa terhadap masing-masing skenario. Analisa dapat 

dilakukan pada beberapa parameter seperti laju produksi, kumulatif 

produksi, peta saturasi minyak sisa, peta perubahan pH dan lainnya. 

Namun pada penelitian ini hanya akan terfokus pada perolehan 

minyak. Untuk parameter lainnya yang akan diperlihatkan pada 

penelitian ini adalah peta penyebaran minyak sisa pada layer 1 yang 

ditunjukkan pada Gambar 4.4.  
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Gambar 4.4 Peta penyebaran saturasi minyak Layer 1 

Dari peta diatas terlihat saturasi minyak sisa pada akhir tahun 

produksi masih cukup banyak, sehingga reservoir masih dapat 

diproduksikan sampai beberapa tahun kedepan. Berdasarkan hasil 

penyebaran minyak saturasi dapat dilihat bahwa saturasi minyak sisa 

hasil basecase lebih banyak dibandingkan dengan injeksi air salinitas 

rendah. Hal ini membuktikan bahwa pengurasan minyak untuk kasus 

ini lebih baik menggunakan metode Injeksi air salinitas rendah. 

 

 

a. Penyebaran 
saturasi oil tahun 
pertama sebelum 

b. Penyebaran saturasi 
akhir produksi 
Basecase 

c. Penyebaran saturasi 
akhir produksi Skenario 
1 

d. Penyebaran saturasi akhir 
produksi Skenario 2 
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Selain dengan penyebaran saturasi minyak sisa, dilakukan 

juga Analisa terhadap kumulatif oil masing-masing skenario, sehingga 

dapat terlihat jelas perbedaan hasil pengurasan minyak dengan 

metode Waterflooding dan metode low salinity Waterflooding. 

Hasil prediksi ditunjukkan pada Gambar 4.5. Perbedaan oil 

recovery dari skenario 1 dan skenario 2 dengan base case masing-masing 

adalah 2% dan 1% dalam periode prediksi 50 tahun. Recovery factor RF 

minyak kumulatif untuk basecase, skenario1 dan skenario 2 adalah 6.7; 

7.3 dan 7.1 MMbbl. Dari hasil kumulatif produksi perbedaan RF dari 

skenario terlihat tidak signifikan.  

 

Gambar 4.5. Cumulative Production 

Recovery factor RF pada skenario 1 sedikit lebih tinggi daripada 

skenario 2. Dengan kata lain, mengencerkan air formasi 10 kali dan 

20 kali lebih baik untuk kasus ini. Ini bukan fenomena umum pada 
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salinitas rendah. Itu tergantung pada sifat-sifat mineral batuan dan 

komposisi aqueous (air formasi dan fluida yang diinjeksikan). Adapun 

penjelasan tentang mengapa menginjeksikan air formasi pengenceran 

20 kali memperoleh minyak kurang dari 10 kali air formasi 

pengenceran. Karena dalam proses simulasi ini, pelarutan mineral 

batuan dan reaksi air diperhitungkan. Dengan menggunakan 

persamaan Carman-Konzeny yang menghitung reduksi permeabilitas 

sebagai suatu perubahan fungsi akibat pengendapan mineral, semakin 

besar perbedaan salinitas antara air formasi dan fluida yang 

diinjeksikan akan mengganggu kondisi kesetimbangan. Semakin 

rendah oil recovery pada skenario 2 menunjukkan semakin banyak 

terjadinya pelarutan mineral batuan dan hal tersebut menurunkan 

permeabilitas yang berakibat pada semakin rendahnya aliran oil rate. 

Sebagaimana diketahui bahwa pertukaran ion berpengaruh 

pada perolehan kembali minyak, komposisi air formasi dan juga 

pemilihan reaksi harus diperhatikan secara hati-hati. Dari grafik 

produksi minyak kumulatif, kita dapat melihat pemisahan kurva 

setelah 12 tahun. Artinya air injeksi salinitas rendah dapat terlihat 

setelah 12 tahun untuk kasus ini. Mekanisme injeksi air salinitas yang 

rendah pada oil recovery membutuhkan waktu untuk bereaksi, oleh 

karena itu semakin cepat implementasi akan menghasilkan oil recovery 

yang lebih baik. 
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Table IV.4.  Prediksi Produksi Skenario 

Skenario OOIP (MMbbl) Kumulatif 

Minyak (MMbbl) 

Recovery 

factor (%) 

Basecase  

21.78 

6.78 31.14% 

Skenario 1 7.3 33.51% 

Skenario 2 7.09 32.58% 
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BAB  

PENUTUP 

Kesimpulan 

1. Pemodelan Injeksi air bersalinitas rendah dapat dilakukan 

dengan simulator CMG-GEM yang memiliki fasilitas 

perhitungan reaksi pada aqueous phase, mineral reaction, dan 

cation exchange capcity 

2. Pemilihan jenis dan banyaknya reaksi pada simulator 

menentukan detail perhitungan yang mempengaruhi 

lamanya waktu perhitungan. 

3. Semakin rendah salinitas air injeksi tidak selalu 

menghasilkan recovery yang lebih besar. Injeksi air memiliki 

optimum salinity untuk menghasilkan perolehan minyak 

yang maksimal. 

4. Injeksi air bersalinitas rendah memerlukan waktu reaksi, 

sehingga dari hasil simulasi dapat diperoleh waktu 

perkiraan injeksi yang tepat 

Future Research 

 Masih perlu dilakukan sensitivitas salinitas yang lebih detail 

terhadap recovery factor untuk mengoptimalkan hasil permodelan. 
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